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QUICK START GUIDE

EQ8

Claim Your Purchase*
Go to: http://electricquilt.com/claim-eq8 
Complete the checkout process to access the download.

Download the File
Save the file to your computer. By default, most files will 
download into your Downloads folder. 

Install the Software
Double-click the file to start the installation. Follow the 
prompts to complete the installation. 

Activate
This final process tells EQ’s server to activate (or turn on) 
EQ8 on your computer. 

1

2

3

4

Detailed instructions can be found inside this booklet. 

EQ8 License ID and Password

*This booklet comes with any physical copy (retail box) of EQ8. Customers who purchased 
the download directly from ElectricQuilt.com can skip page 4. The “Claim” process is only 

relevant to customers who purchased a physical copy of EQ8.   

See page 9 to locate 
your License ID and 

Password.
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    Thank you...
Thank you for your purchase of the EQ8 software. This guide offers step-by-step instructions 
for downloading and installing your purchase. 

How This Works
The License ID and Password found on the front of this booklet will allow you to download 
the software from the EQ website. Once your license has been verified on our server, you will 
complete the checkout process as if you are purchasing the product for the first time. 

Since you’ve already purchased EQ8, your cost during checkout will be $0.00. Completing the 
checkout process adds your EQ8 download and license information to your ElectricQuilt.com 
account so you can access it in the future.

During the checkout process, you will be asked to create an account, if you do not already 
have one. Record your account credentials here: 

My ElectricQuilt.com Account

Email address: 

Password:  

(When creating your account, do not use the EQ8 password listed on the front of this booklet. The password above 
is for your EQ website account only. It should be something you can remember.)
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STEP 1: CLAIM YOUR PURCHASE
Follow these instructions to claim your EQ8 download. Since you have already purchased 
EQ8, your cost during checkout will be $0.00. Completing the checkout process adds your 
EQ8 download and license information to your ElectricQuilt.com account so you can access it 
in the future. If you do not already have an account on our website, you will be prompted to 
create one during the checkout process.   

1.  	 Go to http://electricquilt.com/claim-eq8
2.  	 Select your computer platform: Mac or PC

3.  	 Enter the License ID and Password found on the front of this booklet.

4.  	 Click Verify My License.

		  Note! If you are upgrading from EQ7, you will be asked to also enter your EQ7 License 
ID and Password at this point. After providing your EQ7 information, click Verify My 
License again to continue.  

5.  	 Once your license is verified, click Add to Cart. The EQ8 software will appear in the 
Cart with a price of $0.00.

Step 2

Step 3

Step 4

6.  	 Click Proceed to Checkout and complete the checkout process. Follow the prompts to 
create an account if you don’t have one already. When the checkout is complete, you 
will see a thank-you page and receive a confirmation email. 

You will need to create an account on the Electric Quilt website to download the software. 
Once you have an account, you will always be able to come back to the website to download 
the software when you buy a new computer or simply need to reinstall.

Customers who purchased the download directly from ElectricQuilt.com can skip page 4. The “Claim” 
process is only relevant to customers who purchased a physical copy of EQ8.   
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STEP 2: DOWNLOAD THE FILE
Once the checkout process is complete, you will see a Download button just above your 
License ID and Password on your order confirmation page, as well as in your email receipt. 
Click the Download button to download the EQ8 installer file.  

How do I find my download?
After you click the Download button, your browser may ask to save the file. Every browser 
handles downloads differently. Refer to the diagrams below to know how to access your file. 

If given the option, save the file in an easy-to-find place. If not asked where to save, the file 
should automatically save into your Downloads folder. Wait for your download to complete 
before moving on to the next step. Downloading may take a bit of time because the file is large.

Do I have to download the file right away? 
No, you do not. Once you’ve completed the checkout (step 1), your download will always be 
in your ElectricQuilt.com account to access later. 

When you’re ready to download your product, simply log into your ElectricQuilt.com 
account, click on My Downloads and click the file to start the download. 

Browser: 
Google Chrome

Browser: 
Mozilla Firefox

Browser: 
Internet Explorer / Microsoft Edge

Browser: 
Safari
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STEP 3: INSTALL THE SOFTWARE
It’s time to install your EQ8 software! Follow the instructions appropriate for your computer 
platform (Windows or Mac). Be sure you have completed steps 1 and 2 on the previous 
pages first.  

 Windows® - Electric Quilt 8 Setup.exe
1.		 Find the Electric Quilt 8 Setup.exe file in your Downloads folder. (Or wherever you 

saved it when you downloaded the file on page 5.) 

2.		 Double-click the Electric Quilt 8 Setup.exe file to start the installation. 

3.		 Follow the prompts through the installation.

4.		 When the installation is finished, you may be asked to Activate your software. Read 
more about Activation on page 8.  
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STEP 3: CONTINUED...

 Mac® - Electric Quilt 8 Setup.dmg
1.		 Find the Electric Quilt 8 Setup.dmg file in your Downloads folder. (Or wherever you 

saved it when you downloaded the file on page 5.)

2.		 Double-click the Electric Quilt 8 Setup.dmg file to view the install window. 

3.		 In the install window, drag the EQ8 icon from left to right and drop it onto the 
Applications icon. You’ll see a box that says, “Copying” indicating that the installation 
process has begun. 

4. 	 When the installation is finished, close the install window. Find the EQ8 icon in Launch 
Pad or in your Applications folder. Double-click to start EQ8. You may be asked to 
Activate your software. Read more about Activation on page 8. 
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STEP 4: ACTIVATE 
Although your EQ8 may be installed, it’s not “turned on” until it completes the activation 
process. Activation sends a signal to EQ’s server to verify that the software is licensed to you 
and that it has not been shared or stolen.  

Windows® users: If your computer is connected to the internet during installation, you may not 
even realize that your EQ8 was activated. Activation happens silently behind the scenes for most 
Windows® users. If you are able to open and use the EQ8 software, then you are successfully 
activated. If you attempt to open EQ8 and you see the Activation screen, then activation did not happen 
during installation.

1.		 Double-click the EQ8 icon to open EQ8. 

2.		 Click the Activate EQ8 button. 

3.		 Enter your License ID and Password (found on the front of this booklet). Click 
Continue to activate the software. 

4.		 Click Continue again to open EQ8. 

If you receive an error code, check your internet connection and firewall/anti-virus 
protection and try again. Activation may have been blocked for a few reasons.

•		  Error 5008: You did not type the License ID and Password correctly

•		  Could not communicate with server: You are not connected to the internet, or you 
have a firewall or anti-virus blocking the signal to EQ’s server

Contact Technical Support if you continue to have issues activating. You can check our 
Support website, call 1-419-352-1134 or use our live chat during business hours, or email 
TechSupport@ElectricQuilt.com.

Step 2 Steps 3-4
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YOUR LICENSE ID AND PASSWORD
Your License ID and Password are located on the front of this booklet. After you complete 
the steps for claiming your purchase (page 4), your License ID and Password will be added to 
your EQ account. Don’t worry if you lose this booklet. As long as you have completed those 
steps, you will always be able to access your license information. 

To find your License ID and Password:

1.		 Go to ElectricQuilt.com. 

2.		 Log into your account.

3.		 Choose My Downloads and locate your EQ8 download. Your License ID and Password 
will be listed next to your download. You can also find your License ID and Password in 
your original email receipt. 

DEACTIVATION AND VALIDATION
You will need to deactivate your EQ8 software in the following cases: 

•	 You are getting rid of an old computer

•	 You want to use EQ8 on more than 2 computers

To Deactivate EQ8
When uninstalling on a Windows® computer, deactivation should happen automatically as 
long as your computer is connected to the internet. Otherwise, you can deactivate manually 
by following these steps:

1. 	 Open EQ8. 

2.		 On the top menu, click Help > 
Deactivate EQ8 on this Computer.

3. 	 Click Yes to the “Are you sure?” 
prompt.

4. 	 Click OK. 
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On how many computers can I have EQ8 installed at a time?
You can have EQ8 installed on as many computers as you wish, however only 2 computers 
can be activated at a time. If you want to use EQ8 on a 3rd computer, you must deactivate 
one of the computers (following the steps on page 9) before activating the 3rd computer. 

Please note: You do NOT need to uninstall EQ8 unless you no longer plan to use it on that 
computer.

What is Validation?
Now that you’ve activated EQ8, your computer can be disconnected from the internet, if you 
prefer. 

Validation is required every 60 days. Validation is a signal that gets sent from your EQ8 to 
our server letting us know that you are using a valid license. If you are disconnected from 
the internet for an extended amount of time, you will receive a warning message letting you 
know you have XX days left to validate your software. 

If you receive this message, simply connect your computer to the internet, then open your 
EQ8 software. 

If you are disconnected from the internet for longer than 60 days, EQ8 will require that you 
re-activate the software. Follow the steps on page 8 to activate.  

Taking a Class?
If you are taking a class, it’s very important that you connect your laptop to the internet and 
open EQ8 so the license can be validated before you go to class. Oftentimes the classrooms 
may not have internet access, so it’s important that you do this before class.

Looking for a class? See page 13.   

Computer 1 activated Computer 2 deactivated Computer 3 activated
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UNINSTALL THE SOFTWARE
 Uninstalling on Windows® 

If your computer is connected to the internet, EQ8 will automatically be deactivated when 
uninstalling. If it is not connected to the internet, you must connect to the internet, then 
deactivate EQ8 before uninstalling. See page 9. 

1.		 Windows 7-8.1: Open Control Panel and choose Programs and Features.  
Windows 10: Click the Windows icon in the bottom-left corner. Click Settings (gear 
icon), then choose Apps. 

2.		 Find and select EQ8 from the list. 

3.		 Click the Uninstall button. Follow the prompts to uninstall.

 Uninstalling on Mac® 
Before uninstalling, you must connect to the internet, then deactivate EQ8. See page 9.  

1.		 If you still have the original install file on your computer (Electric Quilt 8 Setup.dmg), 
continue to the next step. 

		  If you no longer have the DMG file on your computer, go to ElectricQuilt.com, log into 
your account, choose My Downloads and re-download EQ8. 

2.		 Find the Electric Quilt 8 Setup.dmg file on your computer and double-click to open it. 

3. 	 Double-click the trash can at the bottom of the install window. EQ8 will uninstall from 
your computer.
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LEARN AND GET HELP

Find Help Within EQ8
EQ8 is packed with online resources for learning your EQ8 software. To access most of these 
resources, click the Help option on the top menu to display the menu below. 

View Home Screen 
Display the Home Screen for quick access to features, help 
resources and product details.

Online Support Articles 
Use the search feature on the EQ support site to find the 
answers you’re looking for. 

Tutorial Videos 
These videos are a great way to get started. Watch and 
learn! 

Printable Lessons 
There are fully-illustrated printable lessons to help you get 
started. 

Quick Start Guide (PDF) 
Need an online version of this booklet? The lesson and tips in the next sections can be 
downloaded as a PDF. 

Reference Manual (PDF) 
The Reference Manual is a reference guide to all the features of the program. View the 
PDF and print out the pages that are most useful. Check the EQ website for information on 
purchasing a hard copy of the manual.    

Contact EQ 
Can’t find the answers you need? Contact the EQ technical support team by live chat, email, 
or phone. Emails are answered within 1-2 business days, and live chats and phone calls can 
be taken during business hours. (Monday-Friday, 9:00am-4:30pm ET.) 

•		  Find answers on our Support Site: Support.ElectricQuilt.com 

•		  Contact by email: TechSupport@ElectricQuilt.com

•		  Live chat with EQ: ElectricQuilt.com

•		  Get help by phone: 1-419-352-1134
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Find an EQ Class
Look for hands-on EQ classes in your 
area. Enter your location in our class 
locator to find classes near you. Go to 
ElectricQuilt.com, click on Classes > 
Find a Local Class. 

Are you hosting an EQ class? Let us 
know! We are happy to post your class 
on our website to help our customers 
find your class or workshop.  

There are also many online-class options available. Go to ElectricQuilt.com, click on Classes > 
Online Classes to see a list of online class opportunities. 

Online classes are an easy and affordable way to take a class. Sit in front of your computer in 
the comfort of your own home and work through the class at your own pace. 

EQ Academy
EQ Academy is a hands-on EQ workshop near Toledo, OH. 
Started in 2015, students from across the United States and 
Canada travel to learn their EQ software from experienced 
instructors. Hosted by The Electric Quilt Company, members 
of the EQ staff are in each classroom to give individual help 
to students so the teacher can continue to move forward 
with her lessons. Class selections range from beginner level 
to advanced, each covering the basics all the way to the most 
custom features in EQ!

Check ElectricQuilt.com to see when you can sign up for the next EQ Academy!

Kari Schell helping a student at EQ Academy.

Mary Ellen Kranz teaching a beginner class at EQ Academy. 
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ADD TO YOUR SOFTWARE
EQ8 comes with over 6,250 fabrics and over 6,700 blocks in the libraries, but you can add so 
much more! There are lots of free downloads, plus additional libraries available for purchase. 
Check out ElectricQuilt.com to add to your software!

Purchase Add-Ons
The Electric Quilt website has many block, 
fabric, and quilt products to add more to 
your EQ8 software. The contents of these 
add-ons can be used to enhance your 
design process. Download and install these 
add-on products to use with your EQ8 
software today!

•		  Block library add-ons

•		  Quilt project add-ons

•		  Digital fabric library add-ons

Free Downloads
Each month we release a free quilt project 
and a free fabric library for you to download 
and use with your EQ software! Plus there’s 
a huge archive of past downloads! Watch 
our blog for free tutorials and tips for using 
your EQ8 software as well. Be sure you’re 
on our email list to get reminders of these 
free additions.



EQ8 STARTER LESSON
If you’re new to EQ software, this starter lesson is the easiest place 
to begin. Its quick and easy steps take you through designing a very 

basic quilt, to give you a taste for what the software can do. 
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EQ8 STARTER LESSON
This is a quick lesson to jump start your learning. This lesson will 
cover a very basic quilt design using the default blocks and fabrics, 
several of the different coloring tools and pattern printing. 

Find more lessons online and in the add-on lesson books for EQ8.  

Step 2

Step 3 Step 4

1.	 Open EQ8. 

2.	 On the Home Screen, click 
Design a quilt from scratch. 

3.	 On the NEW QUILT tab, 
choose Horizontal Layout by 
clicking on the option on the 
blue ribbon. 

4.	 Click the LAYOUT tab.

5.	 Let’s change the finished 
block size to 6” x 6”. Put a 
check next to Keep width and 
height equal. Click and drag a  
slider bar to the left until the 
numbers get to 6.000. Or, you 
can simply type the numbers 
in both the boxes. 
 
Leave the Number of Blocks 
and the Sashing options as 
they are.  

6.	 Click the BORDERS tab. On 
the top ribbon, change the 
current border style to Corner 
Blocks by clicking directly on 
the Corner Blocks option. 

7.	 The border is currently 1 
inch around the quilt. With 
All checked, move one of 
the slider bars to the right 
to change this to a 2 inch 
border.  

Step 5

Step 6

Step 7
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8.	 Click the DESIGN tab. The 
Block Tools > Set Block 
should be selected and you 
should see the default blocks 
in the palette. 

9.	 Click to select the Ohio Star 
block in the palette.

10.	 Click on the top-left space in 
the quilt to set the block. 

11.	 Let’s put this block in every 
space in the quilt. Hold the 
CTRL key (Command key) and 
click on an empty block space 
in the quilt. 

12.	 Select the Nine Patch Chain 
block in the palette. 

13.	 Hold the ALT key (Option key) 
and click on the second block 
space in the quilt. The ALT key 
(Option key) will set blocks in 
alternating spaces in the quilt. 
This action has replaced some 
of the Ohio Star blocks with 
the Nine Patch Chain blocks. 

14.	 Click the Add to Project 
Sketchbook button. 

15.	 You will be prompted to save 
this file. Name this project, 
“My First EQ8 Project” and 
click Save. The My First EQ8 
Project.PJ8 is now saved to 
your computer.  

16.	 Click the Fabric Tools option 
on the DESIGN ribbon. 

17.	 With the Paintbrush tool 
selected, choose a light blue 
fabric from the palette by 
clicking on it. 

18.	 Click on an orange square 
patch in the quilt. Continue 
to click on the orange square 
patches to color them all. 

Steps 8-10

Step 11 
CTRL/Command+click

Step 13 
ALT/Option+click

Step 14

Step 15 

Step 12 

Step 17

Step 18

All squares coloredSee note on page 18 if you 
don’t see a blue fabric in 

your palette. 
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Step 19

Step 21

Step 22

Step 24

Step 23

Step 20

All star points colored

All triangles colored

All center squares colored

Small blue squares colored

Step 21

Step 22

Step 24

Step 23

Note: Use the horizontal scrollbar at 
the bottom of the palette to view all 
the Sketchbook fabrics. To view more 
fabrics in the palette at a time, click 
on the Detach button  in the fabric 
preview window. Move the preview off 
to the side and make it larger if you’d 
like. This will give room for fabric 
swatches in the palette, plus give you 
a larger preview of each swatch. To 
place the fabric preview back into the 
palette, click the close button.    

19.	 Select the Spraycan tool and 
choose a yellow fabric swatch 
in the palette.

20.	 Click on a blue triangle star 
point in an Ohio Star block. 
Continue to click on a blue 
star point in all the Ohio Star 
blocks until they are colored 
with the yellow fabric.

21.	 Select the Swap Color tool. 
Choose an orange fabric, then 
click on an orange triangle 
in an Ohio Star block. All the 
orange triangles will change 
to the new orange fabric. 

22.	 Select the Paintbrush 
tool. Choose a brown 
fabric and hold CTRL+click 
(Command+click) on the 
center square of an Ohio Star 
block. 

23.	 Select the Eyedropper tool 
and click on one of the large 
light blue squares in the quilt. 
The Eyedropper finds the light 
blue fabric and selects it in 
the palette.

24.	 Click the Swap Color tool. 
Click on one of the small blue 
squares in a Nine Patch Chain 
block. 
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25.	 Choose a dark blue fabric 
and click on one of the small 
yellow squares in a Nine 
Patch Chain block. 

26.	 Click on one of the sides of 
the border to color all four 
borders with the dark blue. 
Use the Paintbrush tool 
to color the corners with a 
lighter blue fabric. 

27.	 Click the Add to Project 
Sketchbook button. 

This time, EQ does not prompt us 
to save our project because we 
already did that in step 15. Now, 
when we choose to save (or Add 
to Project Sketchbook), we’re just 
adding new variations of our quilt 
to this project’s Sketchbook. 

28.	 Click the PRINT & EXPORT 
tab at the top, then choose 
Print on the ribbon. 

Note: The following steps will cover 
printing patterns. You can choose to 
print these patterns now, or simply 
view the Print Preview.  

29.	 Click Yardage. Make changes 
to the selection if you want, 
and choose Preview. 

30.	 To zoom in on the preview, 
click the Zoom In button at 
the top of the screen. With 
your cursor over the top-left 
corner of the yardage, click, 
hold and drag a box around 
the area. Release the mouse. 
The area will become larger. 
Click Zoom Out to return to 
100% view.  

31.	 Click Close on the Preview, 
then Cancel to put the Print 
box away.   

Step 25

Step 25

Small yellow squares colored

Step 26

Step 27

Step 28

Step 29

Step 29

Step 30
Drag a box around the 
area in which you want 
to zoom.  

Preview enlarged for better viewing.
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32.	 Click on an Ohio Star block in 
the quilt to select it. Now click 
Templates. (Block printing 
options are disabled until you 
click on a block in the quilt.) 
Leave all the options as they 
are and click Preview. Click 
Close on the Preview, then 
Close to put the Print box 
away.  

33.	 Repeat these steps to view 
Foundation, Rotary Cutting, 
and any other print options. 

34.	 Click on one of the borders to 
select it. Notice that the size 
is 2 x 24 (finished). 

35.	 Click a corner block to see its 
size in the dimensions box. 
You can always print patterns 
for the borders, but this 
border is simple enough that 
the dimensions are all you 
would need to cut your fabric.  

36.	 Click the View Project 
Sketchbook button. Click on 
the Quilts section to see all 
of your quilt variations you 
saved. Use the bottom scroll 
bar to view them all. Click the 
Blocks section to see your 
blocks’ coloring variations. 
Close the Sketchbook when 
you’re finished. 

This was a quick lesson on 
designing a basic quilt. Know 
that you can always access 
additional blocks and fabrics 
from the Libraries to use in your 
designs, plus there are many more 
customizable features.

Get more lessons and videos on 
our Support Site. Look for lesson 
books on our main website or at 
your local quilt shop. 

Step 32
Select a block first

Step 34
Select a border

Step 35
Select a border corner block

Step 32

Step 32

Step 36

Step 36
View quilts and blocks in your project’s Sketchbook
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QUICK TIPS
This section includes many tips and explanations covering some 

of the EQ8 features asked about most frequently. 
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ABOUT THE HOME SCREEN
When you first start EQ8, the GET STARTED section of the Home Screen is your landing 
page, offering guided help for different features in the program. Use the navigation on the 
left to find quick help, product details and contact information.  

A

B

C

•		  Design a quilt from scratch: Start a new quilt design on the Quilt Worktable. This does 
not start a new project, only a new, blank quilt. 

•		  Start with a Quick Quilt project: Open and work with a pre-designed project. These 
projects have several quilts, blocks and fabrics pre-loaded based on a theme.  

•		  Open an existing project: Open and work with an EQ8 project that you previously 
created. This will offer a list of projects stored in the My EQ8 > Projects directory, but 
you can always navigate to find any EQ8 project (or project from previous EQ versions) 
on your computer. 

DESIGN QUILTS

DRAW BLOCKS

WORK WITH FABRICS

•		  Design a block from scratch: Start a new block design on the Block Worktable. This 
does not start a new project, only a new, blank block. 

•		  Search for block patterns: Open the Block Library to find a pre-drawn block to print 
patterns, design with and/or to edit to make your own. 

•		  Import and edit fabric images: Scan or take a photo of your own fabric, then import it 
into EQ to see it in your quilt design. 

•		  Search fabric swatches: Open the Fabric Library to find a large variety of pre-loaded 
fabric to use in your project. 

Home Screen 
navigation 

Tip of the Day

A B C

Home Screen 
button 
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THE EQ8 WORKTABLES
EQ8 is comprised of 3 worktables, each offering different tools and features for your project. 

Block Worktable
•		  Draw pieced blocks

•		  Draw applique blocks

•		  Draw combination blocks

•		  Create blocks without 
drawing

•		  Trace a photo to create a 
block

Image Worktable
•		  Import your favorite photo, 

then crop, resize, and 
colorize for your photo quilt 
or project

•		  Import photo or scans of 
your fabric stash, then 
straighten, crop and scale for 
use in your quilt 

Quilt Worktable
•		  Design quilts of all layout 

styles, including: traditional, 
modern, custom, strip, one-
patch, baby blocks and more 

•		  Customize borders (choose 
from 22 styles!)

•		  Add blocks, fabrics and 
threads

•		  Visualize quilting

•		  Create quilt labels

Quilt Worktable

Block Worktable

Image Worktable
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WORKSPACE DIAGRAM
The diagram below shows the EQ8 Quilt Worktable (blue), fully labeled to help illustrate the 
workspace. The Block Worktable (yellow) is also shown smaller, with additional content. 

Main Menu

Main Toolbar

Palette

Palette Toolbox

Palette Tools

Palette Sub-tools

Fabric Preview

Most Recently 
Used List

Palette Tabs

Palette Viewer

Home button1

Worktable Tabs

Ribbon Options

Display Options Viewer Scrollbar Viewer Options Layer Tabs2 Hide/Show Layers2

Palette Scrollbar

1 See page 22 for more about the Home Screen.
2 See page 31 for more about Layers.
3 See page 23 to learn about the different worktables.



EQ8 Quick Tips | 25

Worktable Buttons3

Project Name

Status Bar

Palette Options

Precision Bar - Block Worktable only

Worktable Scrollbar

Layer Tabs2
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MAKING WORKSPACE ADJUSTMENTS
EQ8 offers many customizable ways to improve your experience. 

Display Buttons
Every palette that has Sketchbook content 
has display buttons at the bottom. Click 
these buttons to change the size of the 
content in the palette. 

Resize Palette
Hover your mouse over the edge of the 
palette and drag to make it larger or smaller. 
This is very helpful when you have a lot of 
blocks or fabrics in your project. 

Detach Fabric Preview
Detaching the Fabric Preview not only 
provides a larger view of the selected fabric, 
but it also allows space for more fabrics 
to be seen in the palette. Once detached, 
resize and move to wherever works for you. 

Close the Toolboxes
All of the toolboxes can be closed. This 
option is helpful if you want to see more 
fabrics or blocks in the palette. Click the 
triangle to close the toolbox. Remember to 
open up the toolbox to switch tools!

Other Ways to Customize Your Workspace
On the top menu, select File > Preferences > Display to see even more ways to customize 
your workspace. Under Display, you can: move the ribbon to the side of the screen, change 
the tools to smaller icons (shown at right), and 
hide all the palette tips. Depending on your 
screen proportions, a combination of these 
settings may allow for more blocks and fabrics 
to be seen in your palettes. 
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CREATING YOUR OWN DEFAULT PROJECT 
Follow the instructions below to change your default project. The next time you open EQ8, or 
start a new project, you will be starting with the Sketchbook items YOU selected, instead of 
what was pre-loaded in EQ8. 

WARNING: Make sure you are in a new, clean project file, as you don’t want to lose any of 
your in-progress designs.

Delete the Default Content  

1.		 Start a new project. 

2.		 Click View Project Sketchbook.

3.		 Click the Blocks section. You’ll see the pre-loaded default blocks. 

4.		 Click the 3-dot Options button in the upper-right of the 
Sketchbook window. 

5. 	 Choose Clear All Unused Blocks. 

6. 	 Click Yes to the prompt. The Blocks section should be empty. 

7. 	 Repeat steps 4-6 for the Motifs and Stencils tabs in the Blocks 
section, and also for Fabrics and Threads, if desired.  

8.		 Close the Sketchbook. 

9.		 (Optional) Open the libraries and add any new items you’d like. Close the library.

10.	 When you have your project just as you would like, click 
File > Save Palette as Default. Click OK to the prompt. The 
next time you start a new project, you will see your default 
palettes, whether completely empty, or with your own 
content. 

Note: You can also save your default project with newly sorted content. For example, in the Colors 
section of the Sketchbook, you might want to put black and white swatches at the beginning of the 
Color palette. Sort the colors so black and white are first in the list. When you choose File > Save Palette 
as Default, the black and white will always be at the beginning of all new projects.   

Restore EQ’s Default Project
1.		 Click File > Preferences. 

2.		 On the left side, click Restore. 

3.		 Put a check next to Also restore default 
blocks, fabrics, colors and thread. 

4.		 Click the big Restore Default Settings 
button. 

5.		 EQ8 will close. Double-click the EQ8 icon 
to open it again. 



28 | EQ8 Quick Start Guide  •  The Electric Quilt Company

OPENING QUICK QUILT PROJECTS 
Quick Quilt projects are EQ projects that contain pre-designed quilts of a particular theme 
or style. These are great ways to get started with a design without starting from scratch. Edit 
any of these quilts or blocks to the worktable and start editing. 

To open a Quick Quilt project: 
There are 3 ways to open a Quick Quilt project. 

A		  On the Home Screen, choose Start with a Quick Quilt project

B		  From the File menu, choose File > Open a Quick Quilt Project

C		  Click the New Project or Open Project buttons, then click the Start with a Quick Quilt 
project tab

The Quick Quilts are listed on the left side 
of the Project Helper window. Each Quick 
Quilt project contains multiple quilts. Use 
the arrow buttons to view all the quilts in 
each project. Click OK to open a project. 
The Project Sketchbook will appear. Select 
a design in the Sketchbook and click Edit to 
put it on the worktable. 

When a Quick Quilt project opens, it will be 
Untitled, meaning the file hasn’t been saved 
to your computer’s hard drive yet. Be sure 
to choose File > Save Project to save this 
file to your computer. Alternatively, the first 
time you choose Add to Project Sketchbook, 
you’ll be prompted to save the file, if you 
haven’t already. 

A

B

C

A

B

C

Home Screen

Arrow 
buttons

Click OK to 
open a project

Quick Quilts 
Projects list
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PRINTING PATTERNS FROM A QUILT
To print block patterns from a quilt, you must first tell EQ which block you’d like a pattern for 
by clicking on the block in the quilt to select it. 

1.		 Design a quilt on the DESIGN tab. 		

2.		 Click the PRINT & EXPORT tab, then choose Print on the ribbon. 

3.		 Click on a block in the quilt. You’ll see an outline around the block, indicating that it is  
selected. (Note: If you want to print the Quilt or Yardage, you do not need to select a 
block first.)

4.		 Choose a printing option in the palette.  

These options require that you select a 
design in the quilt first. If a design is not 
selected, you will be prompted to do so. 

To print patterns, first 
select the block.

Important! If you have designs on Layers 2 or 3, 
you must select the appropriate layer first, then 
click on the design. Read more about layers on 
page 31. 
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UNDERSTANDING THE BLOCK COLORINGS

Blocks from the EQ8 Library
Every block in the EQ8 Block Library has been colored twice. The first coloring is grayscale. 
The second coloring is done with solid colors from the default color palette. While some 
people like to design using the colored blocks, many prefer to use the grayscale so they are 
designing with value, not with colors. They prefer to color their blocks later with fabrics of 
similar value. 

When you view one of the library blocks in the Sketchbook, the Sketchbook will indicate one 
drawing and two colorings. By default, EQ8 stacks up to 2 colorings per block.  

When Do Blocks Get Stacked?
You can add your own colorings to the library blocks by coloring the patches. You can also 
draw your own blocks, which will have colorings created by you. When you click the Add to 
Project Sketchbook button, a new coloring gets created.

•		  If the block only has 1 coloring (for example, the default blocks and any newly created 
blocks), when you click Add to Project Sketchbook, the new coloring will get stacked on 
top of the first coloring. Now this one block has two colorings (Coloring 2 of 2).	

•		  If the block already has 2 colorings, a new block will get created with the newest 
coloring when you click Add to Project Sketchbook. This new block will have the same 
line drawing (Coloring 0 of 1), but with a new coloring (Coloring 1 of 1).  	  

Coloring 0 of 2
Line Drawing

Coloring 
1 of 2

Coloring 
2 of 2

The selected block is showing Coloring 2 of 2. 
Using the coloring arrows, you can view the 
grayscale and the line drawing. 

Coloring arrows

In previous versions of EQ, the block colorings would stack up to 10 colorings instead of 2. You can 
change this stacking number in Preferences if you prefer to have the colorings stack differently. Choose 
File > Preferences > General and adjust the option for Block Colorings. If you don’t want your blocks to 
stack at all, change the option to 1 in Preferences. However, please know that any library blocks will 
“unstack” the grayscale from the color once they are added to your project. 



EQ8 Quick Tips | 31

UNDERSTANDING LAYERS

Quilt Workable Layers
On the Quilt Worktable, you’ll see 3 tabs at the bottom of your screen. 

Layer 1 
Made up of pieced or 
applique blocks sewn 
together to make the quilt 
top.

Blocks are set onto the quilt 
by clicking into a predefined 
block space.*

Layer 2
For blocks, motifs and text 
that are sewn onto the quilt 
top.

Blocks and motifs are set by 
dragging from the palette 
and dropping them onto the 
quilt. The Adjust tool is used 
to move, resize, rotate and 
skew these designs.

Layer 3
For your quilting and 
embroidery.

Quilting stencils and 
embroidery are set by 
dragging from the palette 
and dropping it onto the 
quilt. The Adjust tool is used 
to move, resize, rotate and 
skew these designs.

Use the Layer icons to turn layers on and off for 
easier designing. Turning a layer off does not 
delete the contents of the layer. It simply hides 
the content. Click the Eye icon again to have the 
content reappear.  

*Layer 1 of a Custom Set quilt does not have 
pre-defined block spaces. Custom Set requires a 
drag and drop method for setting the blocks. The 
Adjust tool is used to move, resize, rotate and 
skew the blocks. 

Click the Eye icon to hide the contents of a layer 

Quilt showing content on all 3 layers
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Snap Setting Suggestions
For the number of snaps, multiply the block size by 4 to get snaps at every 1/4 inch. So a  
6" x 6" block would have 24 Snaps Horizontal and 24 Snaps Vertical.

•		  For pieced blocks based on a standard grid (like log cabins, Ohio 
stars, etc.), have Snap to Grid and Snap to Node turned ON. 

•		  For pictorial blocks (like a foundation pieced bird or realistic 
flower), turn OFF Snap to Grid. Turn ON/OFF Snap to Node and 
Snap to Lines and Arcs as needed.  

BLOCK DRAWING STYLES

Pieced EasyDraw Blocks
The EasyDraw tools are for drawing traditional pieced blocks in a way that is similar to 
drawing with pencil and paper. Click, hold and drag your mouse from one point to the next. 
EQ provides a block outline for you when you start a new block drawing. You can use the Line 
tool and Arc tool to drag from the block’s outside edge dividing the block into patches.

EQ does the rest for you. It 
understands the drawing 

and creates the templates 
that make up the block. 

The Benefits and Rules of EasyDraw
It is not necessary to think in terms of outlining patches. Instead, you draw one line and EQ 
does the rest. That’s why we call it EasyDraw. The technique is intuitive and natural. Draw as 
many segments as you like, letting them cross and intersect one another as needed. 

There is one concrete rule that can never be broken for EasyDraw to successfully create a 
block from your drawing. All segments of the drawing must connect to one another. When 
EQ finds the points where segments touch or intersect one another, it can define the patch. If 
EQ cannot find these points, it cannot define the patch. 

There may be times when the patches you get when you try to color an EasyDraw block are 
not what you expected. When this happens, it’s because your block looked acceptable in 
normal view, but in a zoomed view, you find that segments were not touching one another. 

Start a new block and EQ gives 
you the block’s outside edge. 

Draw a diagonal line from one 
outside edge to the other to divide 

the block into two triangles.  

Good: All lines touch 
creating a pieceable 

block

Bad: No lines from inner 
squares touching outer 

squares

Good: All lines touch 
creating a pieceable 

block

Bad: Lines touch, but 
the sky patches cannot 

be easily pieced
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Pieced PolyDraw Blocks
The PolyDraw tools are for drawing pieced blocks by creating closed patches. These patches 
are adjacent to each other, never overlapping. This is very different from EasyDraw, where 
you simply draw the seam lines and let EQ create the patches. PolyDraw offers several grids 
to work with to create quick pieced blocks. 

This drawing technique is the most unique. It’s more 
of a CAD-type drawing style. To draw a patch, first 
double-click and release on the worktable to anchor 
your drawing line (green square). Move your mouse 
cursor to the next point then single-click and release 
to anchor the drawing line. Continue to single-click and 
release to anchor the drawing line at different points. 
When you return back to the starting point (green 
square), double-click to close the patch.

You can use the Clone and Rotate tools in the palette to 
quickly complete your block. 

Rectangle Grid
Use the PolyLine Tool

Arc Grid
Use the PolyArc Tool

Eight Point Star Grid
Use the PolyLine Tool

Octagon Grid
Use the PolyLine Tool

Circle Grid
Use the PolyArc Tool

Kaleidoscope Grid
Use the PolyLine Tool

Grids and Recommended PolyDraw Tools
Most grids require that you use the PolyLine tool. If the grid has curves, use the PolyArc 
tool. Snap points for PolyDraw are based on the chosen grid. Change the Horizontal/Vertical, 
Rings/Spokes and Dimensions as needed. Check the online help for more information.

Double-click to start and finish a patch.

Layer Tabs
This block type has layer tabs at the bottom of the worktable. The Applique tab can be 
ignored. See page 31 for information on hiding these layers. 
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Applique Blocks & Motifs
The Applique tools are used to create closed shapes or open curves. An open curve can 
represent stitching, like the whiskers on a cat. Click, hold and drag your mouse from one 
point to the next. Release the mouse to finish your patch. Use the Edit tool to adjust the 
shape of your patch or line. 

Appliques need to be closed shapes so EQ can create the patches, however open curves can 
be drawn to be used as stitching lines for embellishments (cat whiskers, for example).

Start drawing the basic 
elements of your block 

design.

Use the Pick and Edit tools 
to copy, paste, resize, 

rotate and shape patches.

When you choose 
Applique Block, you’ll 

have a background patch 
to color. 

When you choose 
Applique Motif, there 

is no background 
patch. 

Block vs. Motif
An applique Block always has a background patch behind the applique. The applique 
is intended to be sewn directly to the block first, before being sewn into the quilt. This 
background patch can be plain or pieced. Blocks can be set on all layers of the quilt. 

An applique Motif does not have a background patch behind the applique. Applique motifs 
are intended to be sewn to the already-sewn quilt top (over sewn blocks, sashing or borders), 
not to a single block. Motifs can be set on Layers 2 and 3 of the quilt. 

Snap Setting Suggestions 
Have Snap to Node and Auto Join Segments turned ON. Snap to 
Grid and Snap Whole Patch to Grid could be helpful if you were 
working with a specific grid. Typically these options are turned off when drawing applique. 

Layer Tabs (Block only)
The Applique Block type has layer tabs at the bottom of the worktable. The PolyDraw tab 
automatically creates the plain background patch behind the applique—making it a block, 
not a motif. The PolyDraw tab can be ignored for this style, unless you would like a pieced 
background. The Applique tab is where you draw your applique designs. See page 31 for 
information on hiding these layers.  
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USING THE ZOOM TOOLS

Zoom Out 
Click the Zoom Out button to go back 1 zoom level. You may have to click this button 
multiple times if you were zoomed in at multiple zoom levels. Keyboard shortcut: 
CTRL+- (Command+- for Mac)

Refresh Screen 
To clean up your screen, click the Refresh Screen button. This is useful when drawing 
complicated blocks, possibly while zoomed in, to clean up any remnant drawings 
without changing your zoom level. Keyboard shortcut: F5

Fit to Worktable 
Click the Fit to Worktable button to return your worktable to the default zoom level. 
This is also a helpful tool if you’ve scrolled your design too far up/down or left/right on 
your screen. Fit to Worktable will put the design back into place. Keyboard shortcut: 
CTRL+0 (Command+0 for Mac)

With the Zoom In button selected, drag a box 
around the area in which you want to magnify. 

The area is now zoomed in. Use the Zoom Out button, or Fit to 
Worktable, to go back to the original zoom level. 

Note: You can also zoom in and out by holding the CTRL key or Command key and scrolling your mouse 
wheel. Use Fit to Worktable to return to the full screen level. 

Zoom In 
To zoom in on a worktable, you need to drag a box with the Zoom In tool around the 
area you want to enlarge. Keyboard shortcut: CTRL++ (Command++ for Mac)

1.		 Click the Zoom In button.

2.		 Move your mouse cursor over the top-left of the area in which you want to 
zoom.

3.		 Click and hold your mouse cursor as you drag down and to the right of the area.

4.		 Release the mouse.

If you drag a small box around an area, you will zoom in really closely. If you drag a large 
box around an area, your zoom level will be very minimal. You may have to zoom in 
again to get closer. 
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KEYBOARD SHORTCUTS

Speed Keys
Use these speed keys on the Quilt 
Worktable to quickly set blocks and/or color 
patches. 

CTRL+click (Windows) 
Command+click (Mac)	
Setting blocks, photos 
Sets blocks in all pre-defined spaces of a 
quilt layout 

Coloring with Paintbrush tool  
When the same block is used multiple times 
in a quilt, holding this speed key while 
clicking will color the same patch in all of 
those blocks at once. 

Coloring with the Spraycan tool 
When the same fabric/color is used multiple 
times in a quilt, holding this speed key while 
clicking will color the matching fabric/color 
in all the blocks at once.

ALT+click (Windows)  
Option+click (Mac)
Setting blocks, photos 
Sets blocks in alternating pre-defined spaces 
of a quilt layout

Coloring with Paintbrush tool  
When the same block is used multiple 
times in a quilt, holding this speed key 
while clicking will color the same patch in 
alternating blocks at once.

Coloring with the Spraycan tool 
When the same fabric/color is used multiple 
times in a quilt, holding this speed key while 
clicking will color the matching fabric/color 
in alternating blocks at once. 

File Handling

Command Windows Mac

New CTRL+N Cmd+N

Open CTRL+O Cmd+O

Save / Add to 
Sketchbook CTRL+S Cmd+S

Editing

Command Windows Mac

Undo CTRL+Z Cmd+Z

Cut CTRL+X Cmd+X

Copy CTRL+C Cmd+C

Paste CTRL+V Cmd+V

Clear Delete Delete/
Backspace

Miscellaneous

Command Windows Mac

Select All CTRL+A Cmd+A

Select last 
drawn 
segment(s) 

Spacebar Spacebar

Flip arc on 
EasyDraw block

Spacebar 
(while 
drawing)

Spacebar 
(while 
drawing)

View 
Sketchbook F8 F8

Close dialog 
box Esc Esc

Zoom in CTRL++ Cmd++

Zoom out CTRL+- Cmd+-

Refresh F5 F5

Fit to 
Worktable CTRL+0 Cmd+0
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TOOL REFERENCE
This section gives a brief summary of each tool in EQ8. For more 

detailed explanations, check the online Support website.  
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QUILT WORKTABLE

Check the online help for information about any 
palette sub-tools.

Block Tools
This toolbox is found on the Quilt 
Worktable. Click the DESIGN tab on the top 
ribbon, then choose Block Tools.

Set Block 
Click on a space in the quilt, or drag and 
drop a block onto the quilt. 

Erase Block 
Click on a block in the quilt to remove the 
block from that space.  

Rotate 
Click a block in the quilt to rotate it 90 
degrees with each click.  

Flip 
Click on an asymmetric block in the quilt to 
mirror it left to right.  

Adjust 
Select a block on the quilt to move, rotate 
and resize it on Layers 2 and 3, as well as 
Layer 1 of Custom Set quilts. This tool is only 
enabled when on the appropriate layer.  

Symmetry 
Click on the quilt to flip and rotate 
asymmetric blocks in 16 different variations. 
This works best with horizontal layouts.  

Eyedropper 
Click a block in the quilt to quickly locate it 
in the palette.  

Open Library 
Opens the Block Library window.  

Fabric Tools
This toolbox is found on the Quilt 
Worktable. Click the DESIGN tab on the top 
ribbon, then choose Fabric Tools.

Paintbrush 
Click on a patch in the quilt to color it with 
the selected fabric.  

Spraycan 
Click on a patch in the quilt to color all 
matching fabrics in the block at one time. 

Swap Color 
Click on a patch in the quilt to color all 
matching fabrics in the quilt at one time.  

Eyedropper 
Click a patch in the quilt to quickly find the 
fabric or color used in the palette.

Fussy Cut 
Click, hold and drag to move the fabric 
around within a patch in the quilt.  

Rotate Fabric 
Click the fabric in the quilt to rotate it within 
the patch.  

Randomize 
Choose an option, then click on the quilt to 
recolor quickly. 

Open Library 
Opens the Fabric Library window.   
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QUILT WORKTABLE

Photo Tools
This toolbox is found on the Quilt 
Worktable. Click the DESIGN tab on the top 
ribbon, then choose Photo Tools.

Set Photo 
Click on a space in the quilt, or drag and 
drop a photo onto the quilt. Photos can be 
set on any layer of the Quilt Worktable. 

Erase 
Click on a photo in the quilt to remove the 
photo from that space.  

Adjust 
Select a photo on the quilt to move, rotate 
and resize it on Layers 2 and 3, as well as 
Layer 1 of Custom Set quilts. This tool is only 
enabled when on the appropriate layer.  

Open Library 
Opens the Photo Library window.   

Text Tools
This toolbox is available when Layer 2 
is selected at the bottom of the Quilt 
Worktable. Click the DESIGN tab on the top 
ribbon, then choose Text Tools.

Set Text 
Hold the keyboard SHIFT key, then click, 
hold and drag to create a text box on the 
quilt. When you release, you’ll have a box in 
which you can start typing. 

Adjust 
Select a text box on the quilt to move, 
rotate, resize and delete it on Layer 2.

Note: Text Tools are only available when Layer 2 
is selected at the bottom of the Quilt Worktable.
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QUILT WORKTABLE

Embroidery Tools
This toolbox is available when Layer 3 
is selected at the bottom of the Quilt 
Worktable. Click the DESIGN tab on the top 
ribbon, then choose Embroidery Tools.

Set Embroidery 
Drag an embroidery design from the palette 
to Layer 3 of the quilt.  

Erase 
Click on a design in the quilt to remove 
it from its space. Use the Adjust tool to 
completely remove the empty space. 

Rotate 
Click an embroidery in the quilt to rotate it 
90 degrees with each click.  

Flip 
Click an embroidery in the quilt to mirror it 
left to right. 

Adjust 
Select an embroidery on the quilt to move, 
rotate, resize and delete it on Layer 3. 

Open Library 
Opens the Embroidery Library window.

Note: Embroidery Tools are only available when 
Layer 3 is selected at the bottom of the Quilt 
Worktable.   

Thread Tools
This toolbox is found on the Quilt 
Worktable. Click the DESIGN tab on the top 
ribbon, then choose Thread Tools.

Brush Thread 
Click a patch in the quilt to color the 
outlines with the selected thread color.  

Spray Thread 
Click a patch in the quilt to color the 
outlines of all matching patches in the block 
at one time. 

Swap Thread 
Click a patch in the quilt to color the 
outlines of all matching patches in the quilt 
at one time. 

Open Library 
Opens the Thread Library window.    
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PRINT & EXPORT TOOLS

Print
This toolbox is found on the Quilt 
Worktable. Click the PRINT & EXPORT tab 
on the top ribbon, then choose Print.

Quilt (Quilt Worktable only) 
Prints a picture of the quilt.   

Yardage (Quilt Worktable only) 
Prints the yardage requirements for your 
quilt.

Block 
Prints a picture of the selected block.   

Templates 
Prints templates of the selected block.  

Foundation 
Prints foundation patterns of the selected 
block. 

Rotary Cutting 
Prints rotary cutting instructions of the 
selected block. 

Embroidery (Quilt Worktable only) 
Prints a picture of the selected embroidery. 
Only available with embroidery selected on 
Layer 3.

Photo (Quilt Worktable only) 
Prints a picture of the selected photo.

Print Setup 
Opens the Print Setup dialog to adjust your 
print settings.

Export
This toolbox is found on the Quilt 
Worktable. Click the PRINT & EXPORT tab 
on the top ribbon, then choose Export.

Image 
Exports an image of the quilt (or the 
selected block) as a *.JPG, *.TIF, *.GIF, 
*.PNG or *.BMP file.

Selection 
Exports an image as a *.BMP file of the 
selected area. Drag a box around an area of 
your quilt to export only that area. 

Metafile (Block Worktable only) 
Exports a vector metafile (*.EMF) to explode 
blocks in another vector software. This is 
only available for Windows computers.

Facebook (Quilt Worktable only) 
Exports an image of your quilt to your 
Facebook page for your peers to see.

Note: The Print & Export options are similar on 
the Quilt and Block Worktables. You may notice 
some of the options are not available on the 
Block Worktable and vice versa.

Also, some printing options do not apply to 
particular quilt elements, and may not be 
available. For example, if you have an applique 
block selected, then Foundation, Rotary Cutting, 
Embroidery and Photo will not be available 
because they do not apply to the selected 
applique block.  

Print options on the Quilt Worktable shown above

Export options on the Quilt Worktable shown above
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BLOCK WORKTABLE

EasyDraw Tools
This toolbox is found on the Block 
Worktable. With an EasyDraw Block 
selected, choose the DRAW tab on the top 
ribbon, then choose Drawing Tools.

Pick 
Click on a segment (line or arc) to select it. 
Selected segments can be moved, resized, 
rotated, deleted and converted to guides. 
This tool does have Advanced options 
available.  

Edit 
Click on a line or arc to adjust the endpoints 
(nodes) or the shape of the curve, where 
applicable. 

Line 
Click, hold and drag your mouse to draw a 
line from point to point on the block.   

Arc 
Click, hold and drag your mouse to draw an 
arc on the block. Use the Spacebar to flip 
the direction of the arc. 

Grid 
Enter the Columns and Rows of your grid, 
then drag diagonally on the block to place 
your grid.     

PolyDraw Tools
This toolbox is found on the Block 
Worktable. With a PolyDraw Block 
selected, choose the DRAW tab on the top 
ribbon, then choose Drawing Tools.

Pick 
Click on the edge of a patch to select it. 
Selected patch(es) can be flipped, rotated, 
cloned and deleted.   

Edit 
Click on the edge of a patch to select it. 
Drag a node to reposition it. Double-click a 
node to delete it. Double-click a line/curve 
to add a new node.  

PolyLine 
This tool will follow straight line grids. 
Double-click to anchor your starting point. 
Single click to anchor additional points to 
create the patch shape. Double-click on the 
starting point to close the patch.     

PolyArc 
This tool will follow straight line and curved 
grids. Double-click to anchor your starting 
point. Single click to anchor additional 
points to create the patch shape. Double-
click on the starting point to close the patch. 
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BLOCK WORKTABLE

Applique Tools
This toolbox is found on the Block 
Worktable. With an Applique Block or 
Motif selected, choose the DRAW tab on 
the top ribbon, then choose Drawing Tools.

Pick 
Click on the edge of a patch to select it. 
There are several options for selected 
patches in the palette.   

Edit 
Click on the edge of a patch to select it. 
Drag a node to reposition it. Adjust the 
handles to reshape curves. Double-click a 
node to delete it. Double-click a line/curve 
to add a new node.  

Draw 
Choose a drawing sub-tool. Each has its own 
capabilities. Drag your cursor on the block 
to draw with these tools.   

Shapes 
Choose a pre-defined shape, then drag your 
mouse on the block to place your shape. 
Use the PatchMaker shapes to create quick 
stars, flowers and scallops.  

Ellipse 
Drag an ellipse onto the block. Use the 
palette options to change the style of the 
ellipse, its shape and size. 

Rectangle 
Drag a rectangle onto the block. Use the 
palette options to change the style of the 
rectangle, its shape and size. 

Tracing Image Tools
This toolbox is found on the Block 
Worktable. With any block style selected, 
choose the DRAW tab on the top ribbon, 
then choose Tracing Image.

Import Image 
Import an image from your computer into 
EQ8. Place as a background image that can 
be used as a guide for tracing a new block.  
(You must go back to the DRAW tab to trace 
the block once the image is set.)  

Position & Resize 
Use these options to position the image in 
the block.  

Crop 
Crop out unwanted edges of the image.

Delete Image 
Delete the current image on the worktable. 
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Create Serendipity
This toolbox is found on the Block 
Worktable. Click the NEW BLOCK tab 
on the top ribbon, then choose Create 
Serendipity.

Frame Block 
Puts a pre-designed frame around the 
selected Sketchbook block.   

Tilt Block 
Tilts the selected Sketchbook block at any 
angle from 0 to 90 degrees.  

Merge Blocks 
Combines the two selected Sketchbook 
blocks into one block. Note that the 
background block must meet specific 
requirements. See the online help.   

Clip & Flip 
Flips and rotates the upper-left quadrant of 
the selected Sketchbook block.  

Shrink & Flip 
Shrinks the selected Sketchbook block, then 
flips and rotates it into 4 different quadrants 
to create a new block.    

Kaleidoscope 
Turns the selected Sketchbook block into a 
kaleidoscope by cutting it 8 ways. 

Fancy Star 
Turns the selected Sketchbook block into a 
star with 5 to 8 points. 

Open Library 
Opens the Block Library window. 

BLOCK WORKTABLE

Edit Options
This toolbox is found on the Image 
Worktable. Click the IMAGE tab on the top 
ribbon, then choose Edit.

Import Image 
Imports an image from your computer into 
EQ8 to edit and add to your project.   

Resize Image 
Adjusts the image size and resolution.  

Scale Fabric 
Ensures the fabric image you have imported 
is at 100% scale, so what you see in your EQ 
quilt or block is what you’d see in your sewn 
quilt or block.   

Rotate 
Options to rotate, shear or straighten an 
image. The Straighten feature is very helpful 
for imported fabric images.  

Crop 
Removes unwanted edges of the image.

Delete Image 
Deletes the current image on the worktable. 

Open Library 
Opens the Photo Library window. 

IMAGE WORKTABLE
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Color Options
This toolbox is found on the Image 
Worktable. Click the IMAGE tab on the top 
ribbon, then choose Color.

Color Balance 
Automatically adjusts color levels in the 
image.  

Red/Green/Blue 
Changes the amount of red, green and blue 
in the image. 

Hue/Sat/Light 
Changes all three dimensions (hue, 
saturation and lightness) of the image’s 
color values.   

Colorize 
Changes the overall color and intensity of 
the image.  

Color Accent 
Selects a hue or range of hues to emphasize 
or isolate while minimizing the hues in the 
rest of the image.

Hue Map 
Adjusts specific hues in your image.

Channel Mixer 
Applies creative color adjustments to an 
image.

Create Colorway 
Creates various colorations of the same 
image. 

IMAGE WORKTABLE

Histogram Options
This toolbox is found on the Image 
Worktable. Click the IMAGE tab on the top 
ribbon, then choose Histogram.

Adjust 
Changes the brightness and contrast of the 
image.  

Equalize 
Increases the contrast in an image. 

Bright/Contrast 
Applies overall and equal adjustments to all 
the pixels in an image.  
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Special Effects Options
This toolbox is found on the Image 
Worktable. Click the IMAGE tab on the top 
ribbon, then choose Special Effects.

Effects 
This option has over 45 different effects that 
can be applied to images, including Artistic, 
Noise, Blur and many more.  

Filters 
This option has 9 different filters that can be 
applied to images, including Sharp/Unsharp, 
and Edge Detection. 

Circular Symm 
Takes a pie-shaped petal of an image and 
turns it into a circular design similar to the 
patterns seen in kaleidoscopes.  

Square Symm 
Uses a square portion of the photo to create 
symmetries within a new 4-quadrant image.  

IMAGE WORKTABLE

Print 
This toolbox is found on the Image 
Worktable. Click the PRINT & EXPORT tab 
on the top ribbon, then choose Print.

Photo Layout 
Interactive layout for placing Sketchbook 
photos on the page in the best sizes and 
positions for printing. This helps utilize the 
space better, especially if printing onto 
inkjet fabric.  

Print Setup 
Opens the Print Setup dialog to adjust your 
print settings. 
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Export
This toolbox is found on the Image 
Worktable. Click the PRINT & EXPORT tab 
on the top ribbon, then choose Export.

Image 
Exports the image as a *.JPG, *.TIF, *.GIF, 
*.PNG or *.BMP file.

Selection 
Exports an image as a *.BMP file of the 
selected area. Drag a box around a portion 
of your image to export only that selected 
portion.  

Worktable Tools
This toolbox is always found in the palette 
on the Image Worktable. 

View Actual Size 
Displays the image at its actual size. The 
image may be smaller or larger than your 
screen can display.

Fit in Window 
Zooms the image larger or smaller to fit the 
entire size of the window.  

Pan 
Grabs to move the image around on the 
screen.

Add as Fabric 
Adds the current image as a fabric in your 
Sketchbook. This works best for fabric 
photos that you have imported and plan 
to use in your quilt design. After using this 
tool, you will find your image in the fabric 
palette on the Quilt and Block Worktables. 

IMAGE WORKTABLE



END-USER LICENSE AGREEMENT
Please read carefully. 

EQ8, including without limitation the software’s source 
code, object code, instructions, graphics, and other 
components (collectively the “Software”), is provided to 
you under license.

COPYRIGHT: The Software is copyrighted 1991-2019 by The 
Electric Quilt Company. 

NOTICE OF RIGHTS: All rights reserved.

No part of this software or its documentation may be 
reproduced or transmitted in any form or by any means, 
electronically, photocopied, recorded, translated into 
a machine language, or otherwise, without the written 
permission of the publisher. 

You may not sell or distribute collections or individual block 
designs from the EQ8 Block Library. You may not use EQ8 
library blocks or other library designs in any commercial 
application, including software. For rights clearance, please 
contact The Electric Quilt Company by email  
customerservice@electricquilt.com or by phone  
419-352-1134 Monday-Friday, 9:00am-4:30pm Eastern.

NOTICE OF TRADEMARKS: Windows® and Microsoft® are 
registered trademarks of Microsoft Corporation. Mac® is 
a registered trademark of Apple Inc. Electric Quilt® is a 
registered trademark of The Electric Quilt Company. Many 
titles used by manufacturers and sellers to distinguish 
their products are claimed as trademarks. Where The 
Electric Quilt Company was aware of these trademarks, 
the trademark symbol was printed beside the trademarked 
title or product name.

GRANT OF LICENSE: This Software is protected by United 
States Copyright law and by International Treaty. Any use 
of the Software in violation of these laws terminates the 
license and can be prosecuted. This Software is licensed, 
not sold.

The Electric Quilt Company grants to you a non-exclusive, 
non-transferable, single-user license to EQ8. By your 
installation and use of this Software you acknowledge that 
you have read this agreement, understand it, and agree to 
be bound by its terms and conditions. 

You agree not to engage in, nor to permit, the 
decompilation, disassembly, attempt to discover the 
source code, or other reverse engineering of the Software.

You may not lend, lease, rent, sublicense, or otherwise 
distribute any portion of this Software. It is software piracy 
to do so and the licensee and others involved in the piracy 
can be prosecuted.

WARRANTY: The Software is licensed “as is” and without 
any express or implied warranties whatsoever. Because 
of the diversity of hardware and conditions under which 
this Software may be used, no warranty of fitness for a 
particular purpose is offered. The user must assume the 
entire risk of using the Software. Any liability of seller or 
manufacturer will be limited to product replacement or 
refund of purchase price.

The Electric Quilt Company does not guarantee or make 
any representations regarding the use or the results of use 
of the Software or any related content or information in 
terms of its correctness, accuracy, reliability, currentness, 
completeness or otherwise. The entire risk as to the results 
and performance of the Software or related content or 
information is assumed by you.

MY DOWNLOADS
Need to re-download EQ8? Log into your 
ElectricQuilt.com account, click on My 
Downloads, and click the file to start the 
download. See page 5 for details.

WINDOWS & MAC 
Need EQ8 for both Windows and Mac? There’s 
no need to purchase the full EQ8 again if you 
want to run it on a second platform. Go to the 
EQ website and search for the EQ8 Migration Kit 
in the search box. For a small fee, this download 
will give you the installation files for the second 
platform. 

CONTACT EQ
The Electric Quilt Company 
500 Lehman Ave, Suite 202 
Bowling Green, OH 43402

Business Hours: 	  
Monday-Friday, 9:00am-4:30pm ET

Support Phone and Email: 	  
1-419-352-1134 	  
TechSupport@ElectricQuilt.com 

Sales Phone and Email: 	  
1-800-356-4219	  
Sales@ElectricQuilt.com

General Email: 	  
CustomerService@ElectricQuilt.com

Website and Live Chat: 	  
https://www.ElectricQuilt.com/

Follow us on social media!


